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dtSearch Web quick start
dtSearch Web is a search engine that you can install on a Web server to publish documents on your web
site. It can perform fast indexed searches using the same search features that dtSearch Desktop
supports -- fuzzy searching, phonic searching, natural language searching, boolean logic, proximity, etc.
Indexed documents can be in any format that dtSearch supports, such as HTML, PDF, XML, Word, Excel,
PowerPoint, and ZIP archives.
After a search, dtSearch Web will convert documents as needed to HTML for display, with hits
highlighted. If a retrieved document is already in HTML, dtSearch Web will display it with hits highlighted
while preserving the HTML attributes (so links and images will work in your browser).
This Quick Start will describe how to get a basic search form running on your web site with minimal
effort. You can create any number of search forms, each with its own set of option settings and index
selections. For information on setting up dtSearch Web to run from a CD, DVD, or other portable media,
see CD Publishing (Overview).
1. Install the dtSearch and dtSearch Web program files on your web server.
dtSearch Web requires Microsoft Internet Information Server (IIS), which is included with
Windows. For supported Windows versions, see dtSearch Web system requirements and performance.
For instructions to install the required IIS components, please see:
How to install dtSearch Web on Windows Server 2016, 2012, or 2008
How to install dtSearch Web on Windows 10, Windows 8, Windows 7, or Windows Vista

2. Make the document folders accessible on your web server
To provide access to documents on your web server, designate each folder that contains documents
to be published as a virtual directory in IIS. IIS will automatically include subfolders of a virtual
directory that you create, so you only need to define the top-level document folder as a virtual
directory. To allow anonymous access for document searches, the document folders and index
folders must have read permission enabled for the IUSR account.
3. Build an index of your documents
dtSearch Web uses the same indexes as dtSearch, so if you already have a dtSearch index of the
documents that you want to make searchable, you can use this index with dtSearch Web. If not,
follow the dtSearch Quick Start to set up an index. If you are indexing a dynamically-generated web
site (such as a web site generated by a content manager) see "How to use dtSearch web with
dynamically-generated content" for information on using the dtSearch Spider to set up your index.
The index folder must also have read permissions enabled for the IUSR account to allow anonymous
access for searching.
For faster display of search results, you can use the "Create Index (Advanced)" dialog box to enable
the "Cache document text in index" option when you create the index. If you do this, a user who is able
to search an index will also be able to open any documents that are cached in the index. Therefore,
if documents are subject to security restrictions, the same security restrictions should apply to the
index folder, if the documents are being stored in the index.
4. Run dtSearch Web Setup
In dtSearch, click File > dtSearch Web Setup. dtSearch Web Setup will display a drop-down list of
the web sites on your server, and below it a list of the virtual directories defined for each site.
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5. Select the web site to use with dtSearch Web
If you have more than one web site on this server, you can install dtSearch Web on each of them, or
just one. (To install dtSearch Web on additional web sites, repeat the procedure described in this
Quick Start for each site.)
6. Select the folder where dtSearch Web should be installed
dtSearch Web Setup will create a "dtSearch" folder under the folder you select where the dtSearch
Web files will be installed. Click the Install or Upgrade button to install the dtSearch Web files in the
folder you selected.
If the folder you selected does not already have 'Execute' permission enabled, dtSearch Web Setup
will ask if it can enable 'Execute' permission in the folder so dtSearch Web can run from that
folder. When dtSearch Web Setup asks if it can register dtSearch Web with Internet Information
Services, answer Yes to have dtSearch Web Setup take care of this automatically.
7. Build a Search Form for your site
Click the Build Search Form... button to build a search form to use with your site. You can make as
many search forms as you want for each site. After dtSearch Web Setup has generated a search
form, you can use an HTML editor to edit the form to fit into your web site.
dtSearch Web provides several alternative templates you can use to create your search form. For
each form you create, select a template from the Template drop-down list to specify the type of
form to generate. Examples of each type of template are available at
http://support.dtsearch.com/support/forms.
In the Form Builder dialog box, click the Indexes tab to select indexes for the search form. Check
the box next to each index to include it on your search form.
8. Click OK to build the search form.
After the search form is built, dtSearch Web will open it in your browser so you can try out a
search. Once you have a basic search form working, you can run Form Builder again to customize
the search form, the appearance of search results, and many other options.
Logging
To enable logging in dtSearch Web, check the Log document access or Log searches checkboxes in the
File tab of the Form Builder dialog box. For information, see Logging.
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Form Builder
Click the Build Search Form... button in dtSearch Web Setup to build a search form to use with your
site. You can make as many search forms as you want for each site. After dtSearch Web Setup has
generated a search form, you can use an HTML editor to edit the form to fit into your web site.

Under the File tab of the Form Builder, you can select the name and location of the search form to
create. When you create a search form, Form Builder will generate a set of files containing JavaScript,
CSS styles, help, and other components of the search form. For details on these files, see Generated
files. To avoid cluttering your other web site folders with these files, you may want to generate the form
in its own subfolder of your web site. For example, if you generate the search form in
c:\inetpub\wwwroot\SearchForms\form1.html, then the other generated files will also go in the
c:\inetpub\wwwroot\SearchForms folder.
Template
dtSearch Web provides several alternative templates you can use to create your search form. For each
form you create, select a template from the Template drop-down list to specify the type of form to
generate. Examples of each type of template are available at http://support.dtsearch.com/support/forms.
The following templates are included with dtSearch Web:
IFrames. The IFrames template is a search form with one IFrame for search results and a second IFrame
for retrieved documents.
No Frames. The No Frames template does not use frames or IFrames for anything. After a search, the
search results will open in a new tab overlaying the search form, and when users click on retrieved
documents, the documents will appear in another new tab overlaying the search results.
Two Frames. The Two Frames template uses two resizable frames, one for the search form and search
results, and a second for retrieved documents.
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Three Frames. The Three Frames template is similar to the Two Frames template, but it adds a separate
frame for the button bar with the "Next Hit", "Prev Hit", etc. buttons. This template is most similar to
the layout used in older versions of dtSearch Web.
Logging
Check the Log searches and Log document access boxes to enable logging of searches from this search
form. For more information on logging options, see Logging.

Search controls
The Search Controls tab in the Form Builder lets you specify the contents of the search form that will be
generated.
Once the form is generated, you can edit it using any HTML editor to match the rest of your web site.

Click a search form type under Select search form type, and click Apply>>, to set up one of the standard
sets of search controls. Once you have done this, you can click Add... or Remove to add or remove
specific controls. Use Move up and Move down to change the order of the controls on the search form.
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Adding a control

To add a control:
1. Select the type of control to add under Control to add.
2. To add a hidden control that specifies a default value, check the Add as hidden value on form box
and select one of the listed values.
To add custom fields such as Subject or Author:
1. Select the Field search field type under Control to add.
2. Enter the name of the field under Field name.

Selecting indexes to include
In the Form Builder dialog box, click the Indexes tab to select the indexes that you want to put on the
search form. Check the box next to each index to include it on your search form.
When you check the box next to an index name, dtSearch will include that index in the list of indexes on
the search form.
Check the box to Encrypt index paths in search form to have the search form use numeric codes instead
of folder names to identify indexes in the search form.
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FindPlus® Integration
dtSearch FindPlus integration allows a dtSearch Desktop user to combine searches of local and network
indexes with dtSearch Web searches through the dtSearch Desktop user interface. If some of your users
will have dtSearch Desktop, check the box labelled Make these indexes accessible to users through
dtSearch Desktop to allow these users to search directly from dtSearch Desktop. The search form
generated will have a "Get index library" link added that these users can click on to integrate dtSearch
Desktop with your site. Once a user has done this, the indexes listed on your search form will be added
to the user's Search dialog box in dtSearch.
Please see the "Searching using dtSearch Web" topic in the dtSearch help file for more information.

Search results format
The Search Results tab in the Form Builder lets you change the way dtSearch displays the results of a
search.
Items to include in search results list
Add or remove items that will appear in search results. To remove an item on the list, un-check the box
next to it. Click the Add... button to add a new item. For each item, you can use Modify... to customize
the way it appears in search results.
Search results header
Search results footer
This is the HTML that appears at the top and bottom of the search results list. You can modify it to
change the way search results appear. The header and footer can contain the following special codes:
Symbol

Meaning

%%Request%%

The search request that the user entered.

%%FileCount%%

The number of documents retrieved.

%%HitCount%%

In search results, the total number of hits in all files. For a
document, the number of hits in the document.

Display the PDF Title as the filename for PDF files
PDF files have a "Title" attribute that is usually more readable than the filename. Check this box to
make the Title appear in search results instead of the filename.
Display the HTML <TITLE> as the filename for HTML files
HTML files also have a title, included between <TITLE> and </TITLE> tags in the file, that is often more
readable than the filename. Check this box to make the HTML title appear in search results instead of
the filename for HTML files.
Remove scripts from HTML files when highlighting hits
HTML files often contain JavaScript code that may not work properly when the file is displayed outside
of its usual context. For example, the JavaScript may refer to documents or objects that would appear
in another frame. Check this option to have dtSearch remove any JavaScript it finds in an HTML file
when highlighting hits. (The original HTML file will be unaffected. This option only affects what
dtSearch Web will display when highlighting hits in an HTML file returned after a search.)
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Highlight hits in documents indexed using the Spider
Check this box to enable highlighting of hits in documents that were indexed using the Spider. To make
hit highlighting faster, create your index with the "Cache original documents" option enabled.
Use HTTP proxy
When highlighting documents indexed using the Spider, dtSearch Web must download a local copy of
the file (unless the index was created with caching of original documents enabled). Check the "Use
HTTP Proxy" box, and supply the URL of the proxy server to use, if dtSearch Web should use a proxy
server when downloading web pages.

Modifying a search results item
When you click Add... or Modify... in the Search Results tab of the Form Builder, you can specify the
content of an item to appear in search results.

Name
The name of the item. This name is only used in the list of items in the Search Results tab and is not
displayed in search results.
Label to appear in search results
This label is any HTML that you want to appear in front of the item. For example <B>Date:</B> would
put Date: in front of the field.
Content
This is the information about the document that you want to appear in search results. The following
pre-defined fields can be used:
String

Purpose

%%Hits%%

Hit count

%%Filename%%

Name of the retrieved document
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%%Location%%

Path to the retrieved document

%%Date%%

Modification date of the document

%%Size%%

Size of the document

%%Synopsis%%

Brief segment of text showing the first few hits in context

%%Title%%

Text from the first few lines of the document, or the TITLE
of an HTML document

Additionally, if you have stored user-defined fields in the index, you can insert these as well. For
example, if you set up a stored field named "Subject", put %%Subject%% in the Content to insert the
value of this field for each document.
Link properties
Select the type of link to insert for this search results item, if any.

Document display options
The Document Display Options tab in the Form Builder lets you specify how documents will appear in
search results.
Before hit
After hit
Code to insert before and after a hit for hit highlighting.
File types to display without conversion to HTML
List any file types that you want dtSearch Web to display without conversion to HTML. For example, if
you want the Microsoft Word viewer plug-in to display .DOC files, add DOC to the list. PDF files are
always displayed in Adobe Reader, without conversion to HTML.
Highlight hits using multiple colors
By default, all hits are highlighted using a yellow background. Check this box to have dtSearch Web
highlight each search term hit using a different color. The colors used are the same ones used in
dtSearch Desktop (Options > Preferences > Fonts and Colors).
Allow display of documents that are not located in a virtual root folder
This box should not be checked unless for some reason it is impossible to create a virtual directory for the
documents on your site. Please see the Security topic before changing this setting.

Logging
dtSearch Web can log searches and document access to text files that you can use to generate
reports. The log files are generated in CSV format, which you can import into Excel or most
databases. The document access log will only log access to documents that have hits
highlighted. dtSearch Web has no way to monitor access to documents that users open directly,
without hit highlighting.
The location for the log file must be a folder that allows write access by the user account(s) that will be
searching. For anonymous access, this is usually the IUSR account. Therefore, you may want to create
a separate folder just for the log files.
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To enable logging in dtSearch Web, check the Log document access or Log searches checkboxes in
the File tab of the Form Builder dialog box.
This will set up the search form for default logging of search requests or document access. Each search
form can have its own separate log settings.
You can also enable logging for a search form by directly editing the generated options file. Directly
editing the file gives you access to low-level options such as the fields that will be included in the log.
The entries in the generated options file that control logging are listed below. The
DocumentLogNameTemplate and SearchLogTemplate control the locations of the log files.
<BR><HR><I>Log searches: </I>
<!-- $Begin LogSearches -->
1
<!-- $End -->
<BR><HR><I>Log document access: </I>
<!-- $Begin LogDocumentAccess -->
1
<!-- $End -->
<BR><HR><I>Document log name template: </I>
<!-- $Begin DocumentLogNameTemplate -->
c:\temp\dtSearchWebLogs\dtSearch Docs %%Year%%%%Month%%.log
<!-- $End -->
<BR><HR><I>Document log item template: </I>
<!-- $Begin DocumentLogItemTemplate -->
%%DateTime%%, "%%REMOTE_USER%%", "%%REMOTE_ADDR%%",
"%%DocName%%", "%%Result%%"
<!-- $End -->
<BR><HR><I>Search log name template: </I>
<!-- $Begin SearchLogNameTemplate -->
c:\temp\dtSearchWebLogs\dtSearch Search %%Year%%%%Month%%.log
<!-- $End -->
<BR><HR><I>Search log item template: </I>
<!-- $Begin SearchLogItemTemplate -->
%%DateTime%%, "%%REMOTE_USER%%", "%%REMOTE_ADDR%%",
"%%SearchRequest%%", "%%SearchIndex%%", %%DocCount%%,
"%%Result%%"
<!-- $End -->
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Publishing (Overview)
dtSearch Publish provides an easy way to publish documents on a CD, DVD, or other portable media,
using a browser-based user interface so users can access the content as they would access a web
site. dtSearch Publish uses the same search components and templates as dtSearch Web, so the search
forms and customization options look exactly the same as for dtSearch Web running on a web server.
Note: a dtSearch Publish distribution license is required before media containing dtSearch components
can be distributed to users.
Some advantages of a browser-based user interface are: it provides high-quality display of HTML files, so
web sites will appear just as they do on the original site; it can be customized simply by changing some
HTML files; it is easy for customers to use; and no software has to be installed on the user's hard disk to
access the content.
As with dtSearch Web, PDF and HTML files are displayed exactly as they would appear in a web browser,
but with hits highlighted. Other file types are converted to HTML with hits highlighted for display in the
browser. To use a CD or other media created with the CD Wizard, the user needs to have Windows XP
or newer and, for viewing PDF files, Adobe Reader. To enable hit highlighting in PDF files, the user will
need a compatible PDF viewer and may need a plug-in. For more information, please see "PDF viewers
that support highlighting hits".
Note: While this manual refers to publishing to "CD", the content can be located on any type of media
that is accessible through the file system, including DVDs, flash drives, USB drives, internal drives, etc.
For step-by-step instructions to create a CD from your documents, see Using the CD Wizard .
For detailed technical information about how the CD software works, see:
CD Types
Standard CDs
Local HTTP Server CDs

Using the CD Wizard
The CD Wizard helps you to create one or more CD master folders. Each folder contains a set of
documents, software, and dtSearch indexes that is ready to be transferred to a CD. You can create any
number of CD master folders, and each folder can contain any number of document folders and indexes.

Creating a CD
To create a CD master folder,
1. Install the dtSearch Publish program files on your computer.
If you have dtSearch Web on CD, run the setup program to install. If you downloaded dtSearch
Web from the internet, follow the download instructions to open the dtSearch Web archive and
install the files.
2. Start the dtSearch CD Wizard
In dtSearch, click dtSearch CD Wizard... in the File menu.
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3. Make a new CD master folder
Click New CD... to make a new CD master folder, enter the name of the folder for the CD contents,
and click OK.
4. Add documents to the CD
Click Add Documents... to add documents to the folder. The Add Documents dialog box will
appear. When the CD master folder is set up, a root\data folder will be created where the
documents should be stored. To add documents to the CD, you can copy them into this folder using
Windows Explorer, or you can use the Add Folder... button to have the CD Wizard do this
automatically. When you click OK after selecting a folder to add, all of the documents in the folder
will be copied into the CD master folder.
5. Create an index for the documents
Click Create Index... to create an index for the documents. You can create any number of indexes
on each CD (just click Create Index... for each one). The process of creating and updating an index
works exactly as it does in dtSearch Desktop.
6. Build a search form
Click the Build Search Form... button to build a search form to use with your site. You can make as
many search forms as you want for each site.
After the search form is built, dtSearch Web will open it in your browser so you can try out a
search. Once you have a basic search form working, you click Build Search Form again to customize
the search form, the appearance of search results, and other options, and to create additional
search forms.
7. Make a "home" page for the CD
The home page is the first page that users will see when they insert the CD. The home page is
named index.html and is located in the root\data subfolder of the CD master folder.
Once the CD is done, transfer the contents of the CD master folder to a CD. Copy the contents of the
CD master folder, but not the CD master folder itself. For example, if the CD master folder is
C:\CDMaster, there should not be a folder named CDMaster on the CD, but everything in C:\CDMaster
should be copied to the CD. (This way the autorun.inf file that the CD Wizard creates will be in the root
folder of the CD.)

Modifying a CD
To add more documents, click Add Documents... and copy additional folders to the CD. After you have
added documents click Update Index... to add the new documents to your indexes.
For information on changing the CD type, see CD Types.

Deleting a CD
To delete a CD master folder, just delete the folder in Windows Explorer. The CD Wizard will detect that
the folder is gone the next time it runs and will remove it from the drop-down list of CD master folders.

"Recognizing" a CD
To access a CD master folder that the CD Wizard does not list (for example, if the CD master folder was
copied from another computer), click Recognize CD and browse to the CD master folder. The CD master
folder will be added to the list in the CD wizard.
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CD types
dtSearch Publish can generate two types of CDs:
(1) "Standard" CDs that use the dtSearch Publish viewer, lbview.exe, to view content on the CD.
(2) "Local HTTP Server" CDs that use Internet Explorer to view content on the CD, and use a localhost-only
HTTP server to enable Internet Explorer to access the CD.
For most applications, the "Standard" CD type is recommended.
To change the type of a CD that you have already set up, click Change CD Settings... and select one of
the CD types.

Standard CDs
A Standard CD uses a viewer program, lbview.exe, to view content on the CD. Web pages and search
forms appear exactly as they would in Internet Explorer, and all search functions work as they would on
a web site, including any JavaScript embedded in search forms.
Because no HTTP server is needed, the CD is not affected by firewall software such as Zone Alarm,
Norton Internet Security, and the Windows Firewall.

CD Layout
The top-level folder of the CD will contain these files:
autorun.inf

Specifies the program to start when the CD is inserted

cdrun.exe

The program launched when the CD is inserted, as
specified in autorun.inf

cdrun.xml

Options specifying what cdrun.exe should do when it starts

Below this folder will be a root folder with two sub-folders:
•

data, which has documents, indexes, and the search forms, and

•

cgi-bin, which has the search program and any other executable content that you add to the CD.

The root\data folder will be equivalent to the / folder on a web site, so /something.html would be found
in root\data\something.html
The root\cgi-bin folder will be equivalent to the /cgi-bin folder on a web site, and can hold any CGI
programs for the web site.

Startup
The startup sequence when a CD is inserted into a user's CD drive is as follows.
1. Windows opens the autorun.inf file to get the program to launch, which is cdrun.exe.
2. cdrun.exe starts and checks that the components listed in the dependencies section of
cdrun.xml are present. If any components are missing, cdrun.exe will display a warning message
(as specified in cdrun.xml) and exit.
3. cdrun.exe launches lbview.exe, the browser that accesses the CD.
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4. lbview.exe starts and checks the lbview.ini file for the recommended Internet Explorer and
Adobe Reader versions. If either product is older than the recommended version, the user will
be prompted to download the latest version from the Microsoft or Adobe web site.
5. lbview.exe opens the home page for the CD, root\data\index.html
6. If the user clicks the search icon in the browser, the search page for the CD will open,
root\data\dtsearch.html

System Requirements
Windows version: Windows XP SP 3 or later.
Internet Explorer version: Internet Explorer 6 or later is required to enable hit navigation and hit
highlighting to work.
Adobe Reader version: A PDF viewer that supports highlighting hits is required or PDF files will appear
without hit highlighting. For information on PDF viewers that support hit highlighting, please see PDF
viewers that support highlighting hits.

Error Pages
The root\data\builtin folder on the CD contains these pages that are displayed in lbview.exe when an
error occurs.
GetNewIE.html

Appears at startup when the Internet Explorer version is
older than what is specified in lbview.ini as the minimum
recommended Internet Explorer version. This page
contains a link that the user can click to suppress the page
from appearing the next time the CD starts.

GetAdobe.html

Appears at startup when the Adobe Reader version is
older than what is specified in lbview.ini as the minimum
recommended version. This page contains a link that the
user can click to suppress the page from appearing the
next time the CD starts.

GetPlugin.html

Appears at startup when an Adobe Reader plug-in is
needed to highlight hits in PDF files. This page contains a
link that the user can click to suppress the page from
appearing the next time the CD starts.

Error.html

Appears when any other browsing error occurs, such as a
broken link leading to a "page not found" error.

lbview.ini Settings
The following settings in lbview.ini can be used to control the behavior of lbview.exe
HomePage=/index.html
Specifies the first page that opens when the CD starts.
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SearchPage=/dtSearch.html
Specifies the page that opens when the user clicks the search button.
WebLinksInBrowser=1
Specifies whether external links should open in the user's web browser or in the lbview.exe
program. For example, suppose a page on your CD contains a link to http://www.microsoft.com. If
WebLinksInBrowser is set to 1, when this link is clicked the user's web browser will open over the
lbview.exe program. If WebLinksInBrowser is set to 0, the link will open in the lbview.exe program.
ExternalLaunchExtensions=xls;doc;ppt;wpd;docx;pptx;xlsx;rtf
List extensions to launch outside of the lbview.exe program. This enables you to create links in the CD
to Word or other Office documents and have them open in their application when the user clicks a link.
CopyFileExtensions=zip
List extensions to copy instead of opening when clicked. These extensions can be used to create links to
automatically copy certain files from the CD.
MinimumAdobeReaderVersion=6
Specifies the minimum version of Adobe Reader (or Adobe Acrobat) recommended to use with this
CD. If an older version is present, or if Adobe Reader is not installed, the user will be prompted to get
Adobe Reader from the Adobe web site. If your CD will not contain PDF files, you can set this to 0 (zero).
GetAdobeReaderPage=/builtin/GetAdobe.html
The page to display when a newer version of Adobe Reader is needed.
MinimumIEVersion=5
The minimum version of Internet Explorer recommended to use with this CD. If an older version is
present, the user will be prompted to upgrade.
GetNewIEPage=/builtin/GetNewIE.html
The page to display when a newer version of Internet Explorer is needed.
MinimumPdfPluginVersion=1
The minimum version the dtSearch PDF Search Highlighter Plug-in for Adobe Reader that is needed to
highlight hits. Set to zero to suppress prompts to download the plug-in.
GetPdfPluginPage=/builtin/GetPlugin.html
The page to display when the dtSearch PDF Search Highlighter Plug-in for Adobe Reader is not installed.
EnablePdfHighlightMessage=Would you like to enable hit highlighting for PDF files (currently disabled
in Adobe Reader or Adobe Acrobat)?
SilentEnablePdfHighlighting=1
If PDF hit highlighting is disabled in Adobe Reader 9 or Adobe Acrobat 9, the lbview.exe program can
change this setting to enable hit highlighting before opening a PDF file. You can use
EnablePdfHighlightMessage to ask permission to make this change, or set SilentEnablePdfHiglighting to
have lbview.exe make the change without asking permission.
The option to disable hit highlighting is present starting in Adobe Reader and Adobe Acrobat 9.0, in the
Preferences > Search settings ("Enable search highlights from external highlight server").

Launching Programs from the Viewer
Standard CDs support a special URL format that lets you launch a program from a link in a page on the
CD. To create a link that launches a program,
(1) Put the program in the root/cgi-bin folder under the CD master folder.
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(2) Create a link on a page as follows:
<a href="cmd://launch/YourProgramName.exe">Click here to launch the
program</a>

The lbview.exe viewer will execute the program YourProgramName.exe in root/cgi-bin when this linked
is clicked.

Using Tabs
You can make a link open in a different tab using the target attribute in the link tag, like this:
<a href="othertab.html" target="_new">click here</a>

A user can close a tab by clicking the X icon, or you can create a link to close a tab by using
javascript:window.close(), like this:
<a href="javascript:window.close();">click here to close this tab</a>

Internet Explorer normally pops up a warning message when a script attempts to close a window. To
prevent this, lbview.exe watches for the exact sequence "javascript:window.close();" and closes the
current tab silently when this occurs in a link.

Local HTTP Server CDs
The default and recommended type of CD to use with dtSearch Publish is the Standard type.
A Local Server CD uses an HTTP server to provide the browser interface. When the CD is inserted, the
local HTTP server starts, and Internet Explorer is launched to open the home page for the CD.
This type of CD has a significant disadvantage: the HTTP server may trigger warning messages, or may be
blocked, by firewall software. For the CD to work, the firewall software has to be configured to allow the
HTTP server to "access the internet". The local HTTP server does not really access anything outside of
the local machine, but because it communicates with the web browser using HTTP, some firewall
software treats it as if it were accessing the internet. The Windows Firewall may pop up a warning
message when the local HTTP server starts.
For Local HTTP Server CDs, you can use either the HTTP server that comes with dtSearch Publish,
dts_svr.exe, or another product, Microweb.

Startup
When the CD is inserted, the autorun.inf file on the CD will start the cdrun.exe program on the CD. The
cdrun.exe program will then do the following:
(1) Check the cdrun.xml file to get configuration settings
(2) Check that the computer has any required dependencies. These are listed in the cdrun.xml file. If a
dependency is not present, the file in browserError.html is launched to prompt the user to get a newer
browser version.
(3) Start the HTTP server and then launch the home page for the CD (index.html) in the user's web
browser. When the browser is closed, the HTTP server will stop automatically.
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CD Layout
Assuming that a CD master folder is created in c:\sample, the following sub-folders will be created when
the CD Wizard sets up the CD:
Folder

Contents

c:\sample\root\cgi-bin dtSearch Web program files
c:\sample\root\data

Documents and indexes

System Requirements
Windows version: Windows XP SP 3 or later.
Internet Explorer version: Internet Explorer 6 or later is required to enable hit navigation and hit
highlighting to work.
Adobe Reader version: A PDF viewer that supports highlighting hits is required or PDF files will appear
without hit highlighting. For information on PDF viewers that support hit highlighting, please see PDF
viewers that support highlighting hits.
Firewalls: If the system has a firewall installed, the program dts_svr.exe on the CD may have to be given
permission to access the internet.

HTTP Server
The HTTP server is dts_svr.exe, a localhost-only HTTP server that runs on a unique port number, so it will
not interfere with any other HTTP servers that may be running on the computer when the CD is
inserted. A configuration file, dts_svr.ini, has option settings to control the behavior of the HTTP server
(for example, to specify the browser to open when the CD starts). Documentation on these options is
included in the dts_svr.ini file.
dtSearch Web interfaces with the HTTP server using the dtcgi2is.exe utility, which the CD Wizard sets up
along with dtSearch Web. dtcgi2is.exe translates dtSearch Web's ISAPI interface into a CGI interface, so
dtSearch Web can be run as a CGI program. dtcgi2is.exe maps virtual directories to local directories for
dtSearch Web using the root folder provided in an XML configuration file, dtcgi2is.xml.

Dependencies
If your content requires a current browser version, plug-ins, or other software that must be installed,
you can use the Dependencies entries in the cdrun.xml file to have your CD install these as needed.

Software dependencies
If your content requires a specific browser version, plug-ins, or other software that must be installed,
you can use the Dependencies entries in the cdrun.xml file to have your CD install these as needed. Each
dependency is numbered from 0 to 9 and contains the following information:
Component
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A DLL that must be loaded successfully for the dependency to be
satisfied. The wizard-generated cdrun.xml checks for the Winsock 2
DLL, WS2_32.DLL.

Portable Media Publishing
Message

A prompt that will be displayed if the component is missing. If
FileToLaunch is not blank, the message must be a question asking the
user for permission to install the software. If FileToLaunch is blank,
the message should be an error message.

FileToLaunch

Program to execute if the component is missing (if blank, nothing will
be launched). If the required software is on the CD, this should be
the path to the executable, relative to the top folder on the CD.

ErrorPage

An HTML file to open if the dependency cannot be satisfied. This can
contain links to a web site to download the required software.

Example 1. Displays a warning message if the Winsock 2 DLL is not installed.
<Dependency0>
<Component>ws2_32.dll</Component>
<Message>A newer version of Internet Explorer or Netscape is
needed.</Message>
<FileToLaunch></FileToLaunch>
<ErrorPage>browserError.html</ErrorPage>
</Dependency0>

Example 2. Offers to install Internet Explorer if the Winsock 2 DLL is not installed. This example
assumes that the CD will contain the Internet Explorer setup files in a folder named msie on the CD.
<Dependency0>
<Component>ws2_32.dll</Component>
<Message>A newer version of Internet Explorer is needed.
like to install Internet Explorer now?</Message>
<FileToLaunch>msie\iesetup.exe</FileToLaunch>
<ErrorPage>browserError.html</ErrorPage>
</Dependency0>

Would you

cdrun.xml
The cdrun.xml configuration file controls the behavior of cdrun.exe, which is the program launched to
view a CD created with dtSearch Publish. Each of the option settings in cdrun.xml is explained below.
<?xml version="1.0" encoding="UTF-8" ?>
<dtSearchCdSettings>
<UseLocalBrowser>1</UseLocalBrowser>
<ServerToLaunch>root\data\lbview.exe</ServerToLaunch>
<Dependency0>
<Component>ws2_32.dll</Component>
<Message>A newer version of Internet Explorer or Netscape is
needed.</Message>
<FileToLaunch></FileToLaunch>
<ErrorPage>apache\browserError.html</ErrorPage>
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</Dependency0>
</dtSearchCdSettings>

ServerToLaunch
To start the HTTP web server from the CD, cdrun executes the dts_svr.exe program. dts_svr.exe then
launches the browser with the start page for the CD (default.html or index.html). dts_svr.exe will
automatically close when the user closes the browser window. If UseMicroweb is true (see below) then
ServerToLaunch should be set to root\data\microweb.exe
UseDefaultServer
UseMicroweb
UseLocalBrowser
Specifies the interface type for the CD.
Dependency0
Up to 10 dependencies, numbered from 0 to 9, can be included in a cdrun.xml file, specifying
components or programs that must be installed for the CD to work. See "Software Dependencies" for
information on the contents of this section.
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